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Sesión de Laboratorio 2 

En esta sesión vamos a comenzar a aprender cómo funciona la programación de bajo 
nivel. Ya conoces de la anterior sesión el entorno de trabajo, los materiales que 
vamos a utilizar y el alcance esperado del proyecto que debes realizar a lo largo de 
la asignatura. Ahora vamos a empezar a dar pasos para que puedas llegar a esa 
meta. 

En esta sesión vas a construir tu primer programa en ensamblador, empezando 
desde cero.  

Objetivos 

Los objetivos generales que se persiguen son:  

• Aprender, de forma general, qué es un microcontrolador y conocer el 
microcontrolador PIC16F886, que se utilizará para el desarrollo de todas las 
prácticas de programación en ensamblador. 

• Entender la estructura de la memoria del microcontrolador para poder  
• Familiarizarse con el repertorio de instrucciones del PIC16F886 y saber 

interpretar la información que proporciona sobre el mismo el Data Sheet. 
• Aprender a manejar el entorno MPLAB X IDE para la edición, ensamblado y 

depuración de programas en ensamblador. 

Resultados de aprendizaje 

Tras la realización de esta sesión de laboratorio, deberás ser capaz de: 

• Utilizar correctamente las instrucciones MOVF y MOVWF, para transferencia de 
datos, y ADDWF, ADDLW y SUBWF para cálculos aritméticos. 

• Definir los diferentes elementos que forman parte de un programa en 
ensamblador del PIC (etiquetas, directivas, instrucciones, etc.). 

• Escribir programas sencillos que calculen expresiones aritméticas. 
• Verificar el funcionamiento de un programa utilizando el entorno MPLAB X IDE 

y depurarlo mediante ejecución paso a paso. 
• Acceder a cualquier SFR y GPR del PIC y escribir y leer de los pines del 

microcontrolador. 
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Teoría 

Introducción a los microcontroladores 

A mediados de 2002 se superó la impresionante cifra de 1000 millones de 
procesadores utilizados en la fabricación de computadores. Pero esta cantidad sólo 
abarca entorno al 2% de los sistemas de computación; el 98% restantes son 
procesadores empotrados (entre los que se encuentran los microcontroladores). 

Un microcontrolador (conocido en inglés por las siglas MCU) es un sistema 
electrónico que tiene como finalidad controlar el funcionamiento de ciertos 
dispositivos externos, como sensores, teclados, pantallas, interruptores, etc. Está 
compuesto por un procesador o núcleo de ejecución, memoria para almacenamiento 
de datos e instrucciones y otros módulos que permiten la comunicación con los 
dispositivos que ha de controlar, todo ello integrado dentro de un mismo circuito 
integrado. La capacidad de procesamiento de estos sistemas es muy inferior a la de 
un procesador de propósito general; sin embargo son muy baratos y tienen un 
tamaño muy reducido, lo que los hace ideales para ser insertados en multitud de 
máquinas y equipos, incrementando sus prestaciones. 

Los microcontroladores se programan, al igual que los procesadores de propósito 
general, pero "una única vez". Es decir, a diferencia de los computadores, los 
microcontroladores ejecutan una única aplicación, que es la que realiza las acciones 
necesarias para el control de la máquina donde ha sido insertado. 

Existen más de medio centenar de prestigiosos fabricantes de microcontroladores, y 
cada uno oferta una gran variedad de modelos potenciando en algunos las 
capacidades de memoria, en otros la velocidad de trabajo, en otros la potencia de los 
recursos auxiliares, etc. 

Entre los campos de aplicación se encuentran: electrodomésticos, electrónica de 
consumo, automoción, maquinaria industrial, etc. 

La empresa americana Arizona Microchip (www.microchip.com) fabrica los 
microcontroladores PIC, que han tenido un extraordinario éxito en todo el mundo. 
Actualmente es una de las empresas con mayor volumen de venta de 
microcontroladores, más aún tras la compra de su rival Atmel en 2016. 

Cada fabricante aporta los siguientes documentos para sus microcontroladores: 

• Data Sheet: es el documento más importante, donde se describe al detalle la 
estructura del microcontrolador y las características de todos los elementos 
que lo integran. 

• Family reference Manual: Contiene información muy detallada sobre los 
aspectos comunes de una familia de microcontroladores. 
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• Application notes: documentos que describen aplicaciones llevadas a cabo 
utilizando dicho microcontrolador. Pueden incorporan los ficheros de código 
ensamblador utilizados para crear la aplicación. 

• User Guides: documentos guías para el desarrollo de aplicaciones con los 
microcontroladores; suelen explicar el funcionamiento de los entornos y 
herramientas de desarrollo (programación). 

 

El microcontrolador PIC16F886 

El microcontrolador PIC16F886 es un circuito integrado de 28 pines, que funciona a 
una frecuencia de reloj de hasta 20 MHz. Incorpora un procesador capaz de ejecutar 
35 instrucciones diferentes, tres tipos de memoria (Flash, RAM, EEPROM) para datos 
e instrucciones y numerosos módulos y registros para control de los periféricos que 
se le conecten (temporizadores, contadores, conversores A/D y D/A, puertos de 
comunicación serie y paralelo etc.). 

Arquitectura Harvard 

Los PIC utilizan la arquitectura Harvard, según muestra la siguiente figura:  

 
A diferencia de la arquitectura Von Neumann, la Harvard independiza la memoria de 
datos de la de instrucciones, y utiliza un bus dedicado para cada una de ellas, 
optimizando las capacidades y la longitud de sus palabras y permitiendo accesos 
simultáneos a ambas. En particular, el PIC16F886 contiene una memoria de 
instrucciones de tipo Flash, de 8K palabras, de 14 bits cada una; una memoria RAM 
de datos, formada por 368 bytes (divididos en cuatro páginas o bancos) y otra 
EEPROM de 256 bytes (todos los datos son de 1 byte).  

Otra característica de este procesador es su arquitectura de 1 dirección, es decir, 
arquitectura de acumulador (las instrucciones aritméticas hacen referencia explícita a 

Memoria 
de 

datos

Memoria 
de 

instrucciones Procesador

Unidad de 
control

Unidad de 
proceso

Bus de 
direcciones

Bus de 
instrucciones

Bus de 
direcciones

Bus de 
datos

Memoria 
de 

datos

Memoria 
de 

instrucciones Procesador

Unidad de 
control

Unidad de 
proceso

Procesador

Unidad de 
control

Unidad de 
proceso

Bus de 
direcciones

Bus de 
instrucciones

Bus de 
direcciones

Bus de 
datos



Olga Peñalba Rodríguez y Daniel León 

 

 

4 �  

 
 

un solo operando; el otro se encuentra en el acumulador), con la particularidad de 
que puede elegirse en cuál de los dos operandos escribir el resultado. 

Incorpora los modos de direccionamiento: inmediato, directo e indirecto de registro. 

Cuenta con varios registros específicos, entre los que se encuentran: 

• Contador de programa: almacena la dirección de la siguiente instrucción a 
ejecutarse. 

• Registro de estado (STATUS): de 8 bits, los últimos tres almacenan los bits Z 
(indica si el resultado es 0), DC (indican si ha habido un acarreo al operar los 
4 bits menos significativos de los datos), y C (indica un acarreo al operar con 
los 8 bits del dato) 

Periféricos 

Un microcontrolador incluye una serie de periféricos encargados de la comunicación 
con el exterior que conectados al bus de datos (Entrada/Salida mapeada en 
memoria). Se configuran mediante una serie de registros especiales dentro de los 
“SFR – Special File Register”, de la misma manera que se puede acceder al STATUS 
en la posición de memoria 0x03. 

La imagen de la página siguiente muestra un diagrama de bloques general del 
PIC16F886 donde se detallan los periféricos (extraído de la pág. 14 del Data Sheet). 

De estos periféricos, los más importantes, y en los que nos vamos a centrar en este 
curso, son los puertos GPIO (General-Purpose Input-Output), que están divididos en 
4 bloques: PORTA (8 puertos), PORTB (8 puertos), PORTC (8 puertos) y PORTE (1 
puerto). Estos puertos se corresponden con pines específicos del microcontrolador y 
podremos escribir o leer datos digitales de ellos (0 o 1). 

Cada pin puede configurarse para entrada o salida mediante los SFR TRISA, TRISB 
y TRISC (banco 1 de memoria, como veremos más adelante). El pin E3 es siempre 
de entrada. 

Si un pin está configurado como salida, podremos fijar un valor digital de 0 o 1 
escribiendo en los SFR PORTA, PORTB y PORTC (banco 0 de memoria) como si se 
tratara de un registro normal de datos. 

De la misma forma, si un pin está configurado como entrada, podremos leer el valor 
digital que tiene a la entrada leyendo de esos mismos registros y de PORTE. Hay 
que tener en cuenta que la lectura acepta niveles lógicos CMOS de 5v (0v-1.5v para 
0 y 3.5v-5v para 1) y, aunque aplica histéresis para las transiciones, la lectura de un 
pin en circuito abierto será errática.  
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Estructura de la memoria del PIC16F886 

Como hemos visto, la memoria de 368 bytes está dividida en 3 bancos y se 
corresponde al siguiente esquema (Data Sheet, página 25) 

 



Sesión de laboratorio 2   

 

 

 7 � 

 
 

Para acceder a las posiciones de memoria, o a los SFR ubicados en cada banco en 
particular, tenemos que manipular los bits RP1 y RP0 (bits 6 y 5 respectivamente) 
del registro STATUS, de forma que el número representado en binario de este par 
de bits se corresponde con el banco seleccionado. Nótese que esto es posible porque 
el registro STATUS es accesible desde todos los bancos de memoria. La macro 
BANKSEL del compilador también puede utilizarse como veremos en clase. 

RP1 RP0 BANCO 
0 0 0 
0 1 1 
1 0 2 
1 1 3 

 

Este tipo de acceso se denomina “acceso directo”. En sesiones posteriores veremos 
otra forma de acceder a la memoria, el “acceso indirecto”, que se utiliza, entre otros 
propósitos, para recorrido de estructuras de datos en memoria. 

 

Lenguaje ensamblador 

Entre las instrucciones (35 en total) del lenguaje ensamblador del PIC16F886 
podemos encontrar:  

• aritmético-lógicas: ADDLW, ADDWF, SUBWF, XORWF 
• transferencias de datos: MOVF, MOVWF 
• manipulación de bits: BCF, BSF 
• control de flujo: GOTO, BTFSC, RETURN 
• Instrucciones de control de HW: SLEEP, CLRWDT 

Todas se codifican con 14 bits, pudiendo tener cuatro formatos distintos, mientras 
que los datos son de 8 bits. 

Elementos de un programa en lenguaje ensamblador 

Un programa escrito en lenguaje ensamblador puede contener los siguientes 
elementos: 

• Instrucciones: constituyen el núcleo del programa y son traducidas a 
lenguaje máquina (binario) durante el proceso de ensamblado. Están 
formadas por un código mnemotécnico que identifica la operación, seguido 
por la especificación de los operandos.  

• Directivas: son indicaciones que se introducen en el programa para controlar 
el proceso de ensamblado. No se corresponden con ninguna instrucción del 
lenguaje máquina y, por lo tanto, no generan código en binario, pero afectan 
a cómo se genera ese código. 
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• Etiquetas: son un mecanismo que ofrece el lenguaje ensamblador para 
facilitar el proceso de creación de programas. Tienen un valor numérico, que 
en mucho casos representa una dirección de memoria. 

• Macros: son conjuntos de instrucciones que están agrupadas bajo un nombre 
común (etiqueta). Para ejecutar esas instrucciones basta con escribir el 
nombre de la macro en el punto del programa donde se desee incluir las 
instrucciones. De esta manera se simplifica la escritura del programa. Pueden 
incluir datos de tipo parámetro. 

• Comentarios: son textos introducidos con el fin de facilitar la lectura y 
compresión del programa.  

• Datos u operandos: suelen ser nombres de registros, literales o direcciones 
de memoria. 

 
Elementos de un programa en ensamblador del PIC16F886 

Un programa en lenguaje ensamblador del PIC16F886 puede incluir cualquiera de los 
elementos anteriormente reseñados. Cada línea del programa puede considerarse 
formada por cuatro campos o bloques: 

etiqueta – código – argumentos – comentarios 
 

El único campo obligatorio es el código, que identifica uno de los tres elementos 
siguientes: una instrucción del lenguaje del microcontrolador, una directiva del 
ensamblador o una macro. Se encuentra siempre separado de la primera columna 
por al menos un espacio en blanco o tabulador. 

Los argumentos aparecen o no dependiendo del código (algunas instrucciones, 
directivas y macros no los requieren). Son siempre un número, o un cálculo sobre 
números fijos, representado en cualquier sistema de numeración de los admitidos. 
Cada número puede ser sustituido por una etiqueta previamente definida con el valor 
de dicho número. 

Las etiquetas están formadas por caracteres alfanuméricos hasta un máximo de 32. 
Tienen siempre un valor numérico. Su uso es opcional, aunque las utilizaremos 
habitualmente con el fin de simplificar la escritura y lectura del código.  Además, 
mediante las etiquetas se consigue independizar el código de la zona de memoria 
particular donde se almacene. 

Los comentarios pueden aparecer en cualquier lugar, siempre que vayan 
precedidos por el símbolo “;”.  

Aunque este es el esquema general de las líneas de código, también se permiten 
líneas en blanco dentro del programa, o líneas formadas únicamente por 
comentarios. 



Sesión de laboratorio 2   

 

 

 9 � 

 
 

Instrucciones del PIC16FF886 

Existen en total 35 instrucciones en el lenguaje máquina del PIC16F886, que pueden 
ser combinadas para la creación de programas. La relación de todas las instrucciones 
puede consultarse en el DataSheet del microcontrolador (en la página 232) o en el 
apartado 29 de la referencia de la familia Midrange de PIC. 
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Directivas del MPASM 

Están asociadas al programa ensamblador MPASM. De las numerosas directivas 
disponibles, utilizaremos de forma habitual las siguientes: 

 
• LIST: Con ella habilitamos la creación de un listado de símbolos para el 

procesador que estamos utilizando. Lo usaremos de la forma  
LIST p=16F886 

• __CONFIG: Indica los parámetros de configuración general del 
microcontrolador, como su fuente de reloj o la protección anticopia. En 
condiciones normales no necesitaremos cambiar. 

• INCLUDE: Permite incluir código existente en otro fichero. Lo usaremos de la 
forma  

INCLUDE “PIC16F886.INC” 
para incluir todas las definiciones relativas a elementos del microcontrolador 
que estamos programando. 

• EQU: Sirve para asignar valores a etiquetas. Lo usaremos de la forma  
Etiqueta EQU valor. 

• ORG: Indica a partir de qué dirección de memoria debe situarse el código que 
aparece a continuación. De momento la usaremos siempre como ORG 0x05, 
para que sitúe nuestro programa principal a partir de la posición 5 de la 
memoria flash.  

• END: Indica al ensamblador el final del código fuente, donde ha de finalizar el 
proceso de ensamblado. 

 

 
Uso de mayúsculas y minúsculas 

Son indistinguibles para las directivas e instrucciones (pueden escribirse como se 
deseen y serán reconocidas por el ensamblador).  

Las etiquetas sí deben respetar las mayúsculas y minúsculas utilizadas en su 
creación, tanto las que define el propio usuario como las que se incluyen mediante el 
fichero PIC16F886.INC. 

Con el fin de facilitar la lectura y compresión de programas, utilizaremos el siguiente 
convenio: 

• los nombres de instrucciones se escribirán siempre en minúsculas 
• los nombres de directivas se escribirán en mayúsculas (Upper Case) 
• las etiquetas definidas por uno mismo se escribirán siguiendo el criterio 

UpperCamelCase o Pascal. En minúsculas, pero comenzando por una letra 
mayúscula (ejemplo: Var). Si el nombre de la etiqueta está compuesto por 
dos o más palabras, o trozos de palabras, se escribirá en mayúsculas la 
primera letra de cada palabra (ejemplo: TiempoRetardo). 
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En cuanto a la colocación de los distintos elementos en cada línea, se alinearán por 
columnas (mediante tabulaciones) todos los elementos del mismo tipo: las etiquetas 
irán en la primera columna (si no, el ensamblador señalará una advertencia), los 
códigos de instrucción o directiva en la segunda, los argumentos en una tercera y, 
finalmente, los comentarios en la cuarta columna. 

 

EJEMPLO. El siguiente código es un programa que suma dos datos en memoria. 

 
   ;Suma los datos en las posiciones 20h y 21h de memoria 
   ;y deja el resultado en la posición 22h de memoria 
 
   LIST  p=16F886  ;Define el procesador y habilita listado 
   ORG   0x00    ;Indica al compilador que coloque el programa al 
principio 
 
ResVect goto   Inicio    ;Indica el comienzo del programa  
 
IntVect retfie       ;Vector de interrupción con retorno inmediato 
    
   ORG  0x05    ;Dirección a partir de la cual se ubican  
           ;las instrucciones siguientes 
Inicio  movf   20h,0 
   addwf  21h,0 
   movwf  22h 
   goto   Inicio    ;Vuelve al comienzo de nuevo 
 
   END       ;Fin del programa 

 

 

Constantes numéricas 

El ensamblador MPASM soporta los sistemas de numeración decimal, binario, octal y 
hexadecimal. La siguiente tabla muestra la forma de representar los números según 
el sistema de numeración utilizado. 

 
TIPO SINTAXIS EJEMPLO 
Decimal D'<cantidad>' 

d'<cantidad>' 
. <cantidad> 

movlw D'109' 
movlw d'109' 
movlw .109 

Binario B'<cantidad>' 
b'<cantidad>' 

movlw B'11000101' 
movlw b'11000101' 

Octal O'<cantidad>' 
o'<cantidad>' 

movlw O'155' 
movlw o'155' 
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Hexadecimal H'<cantidad>' 
h'<cantidad>' 
0x<cantidad> 
<cantidad>H (*) 
<cantidad>h (*) 
<cantidad> (*) 

movlw H'6D' 
movlw h'6D' 
movlw 0x6D 
movlw 6DH 
movlw 6Dh 
movlw 6D 

(*) dependiendo de la versión de mpasm, estos formatos pueden dar error si el primer dígito no es 
un número de 0-9. 

Cada número utilizado, independientemente de lo que represente, puede estar en 
cualquier sistema de numeración, y especificado de cualquiera de las formas 
recogidas en la anterior tabla.  

Es importante tener en cuenta que los números pueden representar tanto datos 
como direcciones de datos o direcciones de instrucciones. En cada caso, el número 
de bits empleado en el PIC16F886 es distinto, y, por tanto, también lo es el rango de 
datos válido. 

 
CONSTANTE Nº DE BITS RANGO 
Dato 8 [00h,FFh] 
Dirección de instrucción 13 [0000h,1FFFh] 
Dirección de dato 9 [000h,1FFh] 

 

 

El entorno de desarrollo  MPLAB X IDE 

El entorno MPLAB X IDE es proporcionado por Arizona Microchip para el desarrollo de 
aplicaciones con microcontroladores PIC. Permite escribir programas, ensamblarlos y 
depurarlos, para numerosos dispositivos. Su funcionamiento se describe en el 
documento MPLAB X IDE User’s Guide. Tanto ese manual como el software pueden 
descargarse a través de la página web www.microchip.com.  

 

PASOS para la depuración en MPLAB X IDE: 

1. Crear un proyecto siguiendo los pasos de la primera sesión de laboratorio. 

2. Añadir un nuevo fichero con extensión asm. 

3. Escribir el código del programa. 

4. Añadir el fichero creado mediante el menú Add Files to project del menú Project. 

5. Ensamblar mediante la opción Build Project o Clean and Build Project. 
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6. Una vez ensamblado con éxito, vamos a simular para verificar el correcto 
funcionamiento del programa. Para simular, primero elegir la herramienta de 
debug simulator, accediendo desde el Dashboard a las propiedades del 
proyecto. 

 

7. Lanzar la simulación con la opción Debug -> Debug Project, o con el icono 
asociado. 

8. Comprobar que el programa está correctamente cargado en memoria mostrando 
la memoria de instrucciones a través del menú Window->Target Memory 
View->Program Memory. 

9. Dar valores a las datos del programa. Para ello, mostrar la memoria de datos a 
través del menú Window->Target Memory View->File Registers. Situar el 
cursor sobre el byte de dirección correspondiente a alguno de los datos del 
programa y modificar su valor.  

10. Ejecutar el programa paso a paso , haciendo una pausa y avanzando con los 
iconos (o pulsando F7 o F8) y verificar que funciona correctamente, es decir, que 
en la posición de memoria correspondiente al resultado aparece el valor 
esperado. 

11. Repetir la ejecución con diferentes valores para los datos de partida y comprobar 
que se genera correctamente el resultado en todos los casos. 
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Cuestiones y ejercicios 

E1: El microcontrolador PIC16F886 

Responde las siguientes preguntas sobre las características básicas del PIC16F886 

1. ¿Por qué la memoria de instrucciones es de tipo Flash y no RAM? 

2. ¿Cómo leerías el SFR WDTCON? 

3. ¿Cómo leerías una variable colocada en la posición 0xFA de la memoria? 

4. ¿Cuál es el tamaño de una instrucción?  

5. ¿Cuál es el tamaño del contador de programa?  

6. ¿Con qué nombre se conoce al registro acumulador? 

7. ¿Qué instrucciones del PIC16F886 no llevan argumentos? 

8. ¿Cuáles llevan sólo uno? ¿Qué representa ese argumento? 

9. ¿Cuáles llevan dos? ¿Qué indica el segundo argumento en estos casos? 

10. ¿De cuántas direcciones son las instrucciones del PIC16F886? 

11. ¿Qué hace la instrucción goto? 

12.  ¿y la instrucción movf? 

 
E2: Acciones básicas en lenguaje ensamblador del PIC16F886 

Escribe una o varias instrucciones en ensamblador del PIC16F886 para realizar las 
siguientes acciones básicas. Supón en todos los casos que Var es una variable 
almacenada en la posición h'020' de memoria, y que las constantes del ejemplo 
están representadas en base decimal. 

ACCIÓN EJEMPLO CÓDIGO ENSAMBLADOR 

Inicializar una variable a 0 Var = 0  

Inicializar una variable a un 
valor distinto de 0 

Var = 7  

Incrementar una variable Var = Var + 1  

Decrementar una variable Var = Var - 1  

Sumarle a una variable un Var = Var + 10  
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número constante 

Restarle a una variable un 
número constante 

Var = Var - 15  

 

E3: Constantes numéricas 

Determina para todas las constantes numéricas que aparecen en el siguiente 
programa si representan un Dato, una Dirección de dato o una Dirección de 
instrucción. ¿Cuáles están fuera de rango? ¿Qué ocurre con esos datos? Verifícalo 
utilizando MPLAB X IDE y anota las consecuencias que producen esas situaciones en 
compilación y en ejecución. 

 
LIST   p=16F886 
ORG   o’0’ 
goto  Inicio 
ORG  0x05    

 
Inicio   movlw  h'190' 

subwf   h'021',0 
   movlw  .290 

movwf   h'022' 
goto   0Ch 

  movf   h'020',0 
movwf  h'022' 

  goto   b'0101' 
  movlw  100h 

goto  Inicio 
 
END   

 

 

P1: Programación del PIC16F886 

Escribe un programa en ensamblador del PIC16F886 que permita intercambiar los 
datos almacenados en las posiciones 30h y 31h de memoria. Verifica el 
funcionamiento del programa utilizando el simulador de MPLAB X IDE. 
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P2: Depuración paso a paso 

El siguiente programa debería calcular la expresión matemática  

A = (C + 20) – B 

 
donde A, B y C son variables en memoria, en las posiciones h'020', h'021' y h'022', 
respectivamente, y 20 un valor decimal constante. Sin embargo, no funciona según 
lo esperado. Depúralo con MPLAB X IDE y corrige los errores hasta conseguir que 
calcule dicha expresión. Explica cada error que te vas encontrando. 

 

   ;Programa Ejercicio P2 
 
   LIST   p=16F886 
   ORG   0x00 
   goto   Inicio 
   ORG  0x05     
 
Inicio  movf   h'022' 
   addwf  20h 
   subwf  h'021' 
   movwf  h'020' 
   goto   Inicio 
 
   END 

 

P3: “Blinky”  

Utilizando el esqueleto de programa disponible en el Aula Virtual, realiza un 
programa que lea el puerto PORTA4 y escriba ese contenido en el puerto PORTC4. 
Necesitarás utilizar las instrucciones bcf y bsf. Puedes leer el puerto A completo y 
escribir el puerto B completo si quieres. 

Una vez que compruebes el funcionamiento con MPLAB X IDE, puedes configurar la 
placa, mediante cables, para que el generador de pulsos se conecte al puerto 
PORTA4  y el puerto PORTC4 se conecte a un led azul del array de la parte 
derecha. 


